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About the Accolade Education Program
This module is part of the Sopheon Accolade Education Program (AEP). The AEP modules are
designed to help Accolade users perform the tasks in their company's business process using the
Accolade application. The content in the modules is meant to be used side-by-side with the application,
and is part of the overall documentation suite provided for Accolade.

The benefits of using Accolade as part of your company's innovation development process include the
following:

l Reduced cycle time by displaying clear structure and visibility.

l Reduced rework through timely, properly sequenced completion of all key tasks and milestones.

l Assured positive user experience through properly developed product requirements.

l Improved communication by automating collaboration between multifunctional teammembers.

l Provided decision-making information. Poor projects are stopped or placed on hold so resources
can be redirected to more promising and higher value projects and products.

l Provided clear project requirements. Expectations of a project team and project manager at each
stage are clearly spelled out.

l Managed business risk. Break resource commitments into increments or stages.

l Established key baseline information and metrics.

The Accolade documentation suite contains the following additional components:

Document Contents

Sopheon Accolade What's New in This
Release

For each release, review this document for an
overview of the new features and changes within the
release.

Accolade Online Help Accessible directly through Accolade, the online Help
provides comprehensive how-to and reference
information about all aspects of using Accolade.

Sopheon Accolade Administrator's Guide Provides information for administrative professionals
regarding Accolade setup. This information is also
provided in the online Help.

Sopheon Accolade Installation Guide Provides information about the installation of the
application and its required databases.

Dashboards for Accolade Installation Guide Provides installation information for installing the
Dashboards for Accolade component.

Quick Reference Cards A PDF that can be printed double-sided that provides
quick tips and navigation information for using
Accolade.



Document Contents

Online Help for Accolade Add-ins Accolade add-ins, including Accolade Office
Extensions, Accolade SmartDocuments for Google,
Accolade SmartDocuments for Office, Accolade
Portfolio Optimizer, and Accolade's integration with
Microsoft Project, each include their own Sopheon
created Help file accessible directly from the
application after the add-in is installed. Each Help file
describes how to use the features of that particular
add-in.

Prerequisites for Using this Module
The contents of this training module assumes you are assigned the Accolade user roles and have a
basic understanding of the terms and concepts listed below and how they are used in your installation.
In addition, the content in the related training modules listed below may be helpful before reviewing the
contents of this module.



Charts and Reports Overview
Reporting in Accolade provides a means to summarize and analyze project and other data within your
database in a format and manner that is most applicable to your organization and data needs. Reports
can range from user login attempts to much more complicated charts and reports used to analyze
projects and completion efficiency or financial information. The Charts & Reports page provides a
single location for creating and viewing online reports and charts to which you have access. For
example, a Process Designer can configure a report to have one or many views of the data in different
categories and then the user can cycle through those unique chart views using the cycle icon to look
at the major classifications in a portfolio.

Report Formats
Reports in Accolade can exist in the following formats:

l Accolade Online Reports - Online reports created within Accolade are built and viewable
directly within the application without having to write a SQL query. These reports provide an on-
demand reporting experience and can be used for the creation of Accolade charts. The ability to
create and modify online reports is available to any Accolade user assigned All Reporting Rights,
and anyone with Refresh Workbook Data rights can view these reports. These reports can be
added to the Charts & Reports page within Accolade, and can be added to a pod within a layout
in order to view them in projects.

l HTML Reports - HTML reports can be built using a single SQL query to gather data from the
database, and display as a table in a secondary browser window. This format has no additional
formatting available, so can be useful for simplistic reports, for example, to determine where
process models are being used or to review user access history. HTML reports are also available
for users to send or receive via email. These reports can be added to the Configuration >
Charts & Reports tab within Accolade and can be added to a process model for availability in a
project.

l MS Excel Reports - MS Excel reports are built and viewable in Excel, provide flexibility in
formatting, and are created using the Accolade Office Extensions add-in application. The add-in
provides an interface to create a data report based on Accolade data. You can also create Excel
reports using a template and the Accolade query infrastructure, creating reports based on data
pulled into the spreadsheet using queries. These reports can be added to the Configuration >
Charts & Reports tab within Accolade and can be added to a process model for availability
within a project.

Each report type can contain the same data. The report type you choose to build depends on where the
report needs to display within Accolade, the means you want to use to build the report, and the amount
of formatting required to make the data within the report useful when viewing.

PROC_CreatingHTMLReports.htm


Report Access
Anyone in your organization can design a report, and anyone with All Reporting Rights can create and
save an online report. However, only Administrators and Process Designers can create MS Excel or
HTML reports, or set online reports as available for all users to view within Accolade. Only Process
Designers can associate a report with a process model to display within a project.

Users must have either Refresh Workbook Data or All Reporting Rights for access to view shared
reports in the Charts & Reports page and through the projects to which they have access. If the report
is restricted by role and/or by access group, users must have a system user role that matches the report
and/or be assigned to an access group that matches the report.

Additional rights are required to create and refresh report data using the Accolade Office Extensions
add-in.

Chart Formats
Charts in Accolade can be created using an Accolade online report as a source, and can exist in the
following formats:

l - Bar charts

l - Grouped bar charts

l - Stacked bar charts

l - Bubble charts

l - Line Chart Trends charts

l - Pie charts

l - Radar charts

l - Unknown or custom charts

The chart type you choose to build depends on the data to be displayed, so it is important to select
appropriate data types to render a meaningful chart. For example, a Process Designer can configure
different groupings of data for display in a chart format. The user can then cycle through those various
chart views of the data to understand the performance of a portfolio. Select the cycle icon to view the
different charts.

Note: Line Chart By Columns has been removed as a chart option in Charts & Reports and Charts &
Reports Manager. Users are encouraged to utilize Line Chart Trends as an alternative option.



Charts Access
Using Accolade online report data, users with All Reporting Rights can create charts on the Charts &
Reports page. Administrators and Process Designers can set charts as available for sharing with other
users, and can add a chart to a pod within a layout to display on a project page or as a global link.

Users must have either Refresh Workbook Data or All Reporting Rights for access to view shared charts
in the Charts & Reports page and through the projects to which they have access. If the chart is
restricted by role and/or by access group, users must have a system user role that matches the chart
and/or be assigned to an access group that matches the chart.



Viewing Charts and Reports in Accolade
Reporting in Accolade provides a means to summarize and analyze project and other data within your
database in a format and manner that is most applicable to your organization and data needs.

Charts and reports displayed at a system-level allow users to analyze and compare projects across a
portfolio, while charts and reports displayed at a project-level allow users to summarize a single
project's status and relevant information.

Example

For example, consider a report or chart that contains various project details for every project in the
system. When displayed at a global level, either on the Charts & Reports page or in a page layout
displayed as a global link, it displays the details for all included projects. When displayed at a project
level, in a project page layout, it only displays the given project details.

Viewing System-Level Charts or Reports
The Charts & Reports page provides a single location for accessing and viewing online reports and
charts within Accolade. Users must have Refresh Workbook Data or All Reporting Rights to view an
online report or chart.

The Charts & Reports page is organized into two sections to help users quickly navigate to their
information:

l My Charts & Reports: Items that appear here are considered private. You must be assigned as
an owner of the chart or report, and it is not marked on the configuration side as Available.

Note: An assigned owner with All Reporting Rights can view, update, delete, or add
additional owners to the chart or report. An assigned owner who has Refresh
Workbook Data rights will only be able to view the chart or report.

l Shared Charts & Reports: Items that appear here are considered public. They are available for
users to view if the chart or report is marked on the configuration side as Available. If the item is
restricted to specific roles, users must also have a matching system user role assigned.

Important! The reports that display for selection are based on your access group
permissions as defined in your user profile.

Note: Charts and reports that are included in a page layout can also be viewed within a
global link, if they are included in your company's configuration.

To view an available chart or report:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.



Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Click the name of the chart or report you want to view.

To narrow the list, search by name or category.

3. (Optional, as available and applies to reports only) Click in the upper right corner to download
the current version of the report.

Viewing Project-Level Charts or Reports
In addition to viewing system-wide information in the charts and reports available on the Charts &
Reports page, Administrators and Process Designers can associate charts and reports with a process
model to display data within a project. When viewed through a project, only data that pertains to that
project displays in the chart or report, unlessOverride project filtering is set in the report
configuration.

Charts and reports can be displayed in a project by two different methods:

l Displayed on the project using a Report List pod on a layout - MS Excel or HTML reports are
configured in the pod's advanced settings. Users with appropriate rights can click on a report
name to open it for viewing or downloading, depending on the report's configuration.

Click on the Report List pod on the layout to print the list of charts and reports
that display.

l Added to a project page layout - HTML reports, online reports, and charts created from online
report data can be added to a page layout that is associated with the process model, and can be
accessed by opening the related custom page in the project's page list. This method of displaying
a report allows users to view multiple data sources at one time, and to apply runtime filters in
order to filter the project information displayed in the charts and/or reports.

Applying Runtime Filters to Charts or Reports
Users can apply runtime filters to charts or reports that are displayed within a page layout that is used as
a project page or as a global link. Filters can be used to further modify the data displayed without
making adjustments to the original data source, allowing users flexibility to display the information that is
relevant to their role.

Runtime filters can be selected and applied either to a single report or chart, or to all charts and reports
that are displayed in the layout.

In order to apply runtime filters, the selected reports must be set up with filters that
have runtime filtering enabled, and the selected charts must be created from an
online report with filters that have runtime filtering enabled.



To apply filtering to an individual chart or report on a layout:

1. Display the layout that contains the chart or report to be filtered.

Each chart or report lists the runtime filters that are currently applied.

2. Click in the upper right corner of the chart or report to open the Report Filters dialog box.

The filter categories applied to the selection will appear in the list. If the selection does not have
runtime filters configured, the message "No filters have been defined" will display in the dialog.

3. For each filter row, enter the value to apply as filter criteria.

Important! A value must be defined for all filters in the dialog box. If you do not wish to apply
a particular filter, you will need to set its value to something that will not cause data to be
filtered out.

4. Click Apply to apply the filters and refresh the data displayed.

5. (Optional, as available and applies to reports only) Click in the upper right corner to download
the current version of a report.

To apply filtering to all charts and reports on a layout:

Note: Enable layout filters must be selected on the layout configuration in order to use this
process to apply runtime filters to all charts or reports in a layout.

1. Display the layout that contains the charts or reports to be filtered.

Page Filters appears in the upper left corner, along with a list of the filters that are currently
applied to all charts and reports on the layout. In addition, each chart or report lists any unique
runtime filters that are currently applied.

2. Click to open the Page Filters dialog box.

In order to be available to apply to the layout, filter categories must be included in the
configuration for all charts and reports on the layout.

If the selection does not have runtime filters configured, the message "No filters have been
defined" will display in the dialog.

3. For each filter row, enter the value to apply as filter criteria.

Important! A value must be defined for all filters in the dialog box. If you do not wish to apply
a particular filter, you will need to set its value to something that will not cause data to be
filtered out.

4. Click Apply to apply the filters and refresh the data displayed.

5. (Optional, as available and applies to reports only) Click in the upper right corner to download
the current version of a report.



Using Accolade Tools to Interact With Online Reports
Access the enhanced search, filter, and sort capabilities in Accolade’s Charts and Reports section.
These enhancements allow users to search, filter, sort, and hide/show columns in reports in a more
efficient way and organize pertinent information quickly.

Note: Refreshing the page will reset any filters or sorting.

To column filter all charts and reports in Accolade

l Access the new icon that is located in the column header that will allow users to select filtering
options, using checkboxes, to apply to their report search.

l Utilize the newest search functionality that allows users to find filtering options to apply.

l Use the new icon located at the top right of the report to remove any filters applied to the report.

To search all charts and reports in Accolade

l Select the Search Bar at the top-right corner of the report to keyword search within the report.

Note: The keyword search is not case sensitive.

l Click the X icon in the Search Bar to clear the keyword search data.

To show/hide columns in Accolade

l Select the icon displayed in the top-right corner of the report to show or hide columns within that
report.

l Uncheck the box next to the column name and click the Apply button to hide the column.

To effectively control columns widths in Accolade

l Hover over the header bar in the report to see the lines separating each column. Users can now
click and drag to expand or minimize that specific column.

l Double click the line separating each column to set the column back to the original size (Auto-
Sizing).

l Display full text contents of the cell by clicking onto that specific cell when the text is truncated
due to the smaller size of the column.

To interactively sort all charts and reports in Accolade

l Click on any column header in the report to sort the report based on the data within that column.

l Clicking once on a column will sort in ascending order, clicking twice will sort in descending
order, and clicking a third time will revert to the default report sort order.

l

Click on the Save Preferences icon in the top-right of the report to save your column widths
and hidden columns.



Notes:
l Accolade data is automatically refreshed with current values each time you open a chart
or report.

l To clear the current values set for a runtime filter, click to open the Report Filters

dialog and click in the corresponding filter row. This sets the filter back to the default
settings as defined at the chart level.

l Filter icon will not appear if there are no filters available for users to apply.

l From the Charts & Reports page, you can send an HTML report via email directly to
yourself or to others. Click the name to display the report, and click in the upper right
corner. In the dialog, select the users you want to send the report to and click Done.
Accolade sends a copy of the report to you and the selected users with the same data that
displays to you. If there is sensitive data in the report, take caution in sending it to others.

l If you have Accolade Office Extensions installed on your computer, you can save an MS
Excel report to your computer and then refresh its Accolade data without starting
Accolade.

l To explore "what if" scenarios, save an MS Excel report to your computer, unhide the data
worksheets if necessary, modify the data, and then observe the effect of the changes on
the charts and reports in that workbook. Scenarios can also be created using a report's
filter options.

Accolade Online Reporting Overview
Accolade Online Reporting provides an on-demand reporting option and can be added to the Charts &
Reports page within Accolade. Any Accolade user assigned All Reporting Rights can create online
reports within Accolade.

An online report consists of the following components:

l Data columns - Determines the area of the database, for example Projects or Access Groups,
that are available to retrieve information from.

l Filters - Specifies the criteria to match to include data in the report from specified columns.

l Users - Indicates which Accolade users have access to view and edit the report. Each selected
user must have report refresh rights to see the report. Users with all Reporting Rights also have
access to change the selected columns and filters within the report definition.

Creating Online Reports within Accolade
Online reports provide an on-demand reporting option and can be added to the Charts & Reports page
within Accolade. Any Accolade user assigned All Reporting Rights can create online reports. Generated
content can be added as a report in a project by adding a Report pod to a layout, and then adding the
layout to a process model.



Use the Report Privacy Warning Text system parameter to add a notification
within the report to indicate the content is private or confidential, and should not be
forwarded to others.

To create an online report within Accolade:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the report name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new report - Click Add New and selectOnline Report from the drop-down list.

l To copy an existing report - Locate the report you wish to copy on the Charts & Reports
page.

l

Click in the Copy column. Select, add, or rearrange the columns you wish to
keep. You can also add filters and advanced matrix settings. ClickOK to save
changes and progress to the next step. Give your newly copied report a name, a
system name, a category, and a description. Decide if you wish to transpose the
column and row data. Click Save to create the report.

l To edit an existing report - Click the name of the report on the Charts & Reports page to
open it for editing, Click to edit the report columns, or click to edit the report details.

Only users assigned as report owners and Process Designers with All Reporting
Rights can edit report columns and details.

3. Select a subject from the drop-down list, such as Projects or Users, to display the column sets
available within that subject.

4. Double-click or drag and drop the column names from the left side of the dialog to any area in the
Selected Columns tab to include the column in the report.
l To search for a column, enter search criteria in the Find field after selecting the subject.

l Use the and options to expand or collapse the subject data sets in order to select
specific column options.

l To include an entire column set, drag and drop the column set to the Selected Columns tab.
l To change the column order of selected columns, drag and drop a column into a new location
within the list.

l To display the totals for number columns, check the Show Totals option to indicate that you



would like to sum up a number column into a Totals row at the bottom of the report.

l To remove a column, click in the corresponding row.

5. (Optional) Refine the content of the report as necessary using one or more of the following
options.More...
l Rename columns - Click in one or more selected columns and enter a new column name
that is more appropriate for the report you are creating.

l Set column sorting - Click next to one or more selected columns to indicate whether the
column is sorted in ascending or descending order. If you select more than one column to
sort by, indicate the order in which the columns sort; 1 being the primary sort, 2 the
secondary sort, and so on.

l Create project links - If the Project Name report column is selected for inclusion in the
report, select the Is Link check box to make the project name in a report linkable to the
project's home page.

l Define column properties - In the Properties area, define the column display and behavior
including grouping items together to aggregate them and Excel date intervals. Aggregate
selections are only available for number metric columns.

For example, to summarize the total costs for all projects within a brand, select Sum as the
aggregate value in a column that represents the total costs for a project. The aggregation
displays automatically when the report is selected to display in a chart.

l Data Format - If the column contains a date or a number, select how the data should be
displayed. The currency symbol that displays for numbers is defined in the Currency
Symbol system parameter.

l Hide columns - Make a selection in the Show check box to show or hide columns within the
displayed report.

l Add Count Column - If you select to summarize values within the report, click Add
Count Column to add a column that shows how many rows of source data are combined in
the summary row.

You can order and rename the added column as you can other columns; however,
you can add only one Count column to the report.

l Add Calculated Column - Click Add Calculated Column to add a column to the report
that displays a calculation based on other column data.

6. (Optional) On the Selected Filters tab, double-click or drag and drop the column name from the
left side of the dialog to any area in the Selected Filters tab to use it as filter criteria that data
must match to be included in the report.

7. On the Advanced Matrix Settings tab, if more than one matrix was selected in the report
columns, click Add to add the matrix join definitions.

8. ClickOK to exit the dialog and return to the report settings.



9. Enter the following information to identify the report:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
report.

System Name Enter a unique, shorter name that identifies the report in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among online reports and can contain
only letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this report belongs.More...

Use categories to organize like reports together. For example, if
there are a large number of reports that the IT department uses
to track user logins, use a category to group those reports
together.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the report.

This description helps other users identify the report throughout
the system.

Transpose Select this check box to transpose the column and row data
when the report is rendered.

Owners Click and select the additional users who can edit the report

configuration.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,



Field Description

update, delete, or add additional owners to the report.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the report. To make the
report available for all users or for configuration setup,
you must have a Process Designers with All Reporting
Rights as an assigned owner.

10. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...

Field Description

Override project
filtering

Select this check box to include the entire report set from
within a project.

The report will not filter to project-specific data when viewed
from within a project, and will display all projects in a portfolio
regardless of security.

*Note* This check box will not be available for selection if the
Filter to Portfolio check box is selected.

Filter to Portfolio Select this check box to display the Portfolio Levels To Display
slider.

*Note* This check box will not be available for selection if
Override Project Filtering check box is selected. This check box
is optional and is not mandatory.

Portfolio Levels To
Display

Select this toggle as well as the Filter to Portfolio check box so
that the report will filter to that project Portfolio Hierarchy
instead of the default of filtering down to just that project.

*Note* This toggle is optional and is not mandatory.
Available to Charts &
Reports

Select this check box to make the report publicly available for
users to access and view the report.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able to
view the report in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the report available for use in
configuration.

Roles Select the user roles that have access to view the report.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able to
view the report on the Charts & Reports page.

PROC_PortfolioLevelReporting.htm


Field Description

Configuration
Access Groups

When either Available to check box is selected, access
groups must be defined for the report.

The access groups displayed are based on the current user's
access group permissions and the access groups the report
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the report.

Process Model
Usage

Click the Process Model Usage button to see a list of
process models that the online report is associated with.

The list includes all process models the report is included in,
as well as links to the process model's component tree pages
you have Edit access to.

Note: Clicking either Available to check box will place the report in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the report will only be available to the assigned owners in theirMy
Charts & Reports section.

11. (Optional, available in configuration only) Set up the report for export.

12. (Optional) Click in the upper right corner to display a preview of the report contents prior to

saving, or click to download the report to a spreadsheet file.

13. Click Save to create a new report, or to save changes to an existing report.



Conditional Formatting in Reports

Accolade users need an easy way to focus on the most critical information in the report. Users can
easily use conditional formatting on report columns such as date, number, or text to focus attention on
the key data to drive decisions on projects. Users can specify a formula that tells the report how to color
the background of the cells in a given column. For example, while setting up the report, one can choose
to highlight the project duration column which will show the long-running projects as risks. The user
would be specifying the criteria such as a project running greater than 500 days will have the color red,
projects running between 200 and 500 days will be yellow, and projects running less than 200 days will
be green. This will effectively highlight projects that have been running for a very long time.

1. Access the report you wish to configure.

2. Click the Settings icon at the top right of the report page. The Selected Columns screen
will appear.

3. Select the Settings icon in the Conditional Formatting column. The Conditional Formatting
modal will appear.

4. Configure the fields. Click theOK button when finished.

5. Click the OK button on the Select Columns page to finalize preferences.



How Do I Know the Feature is Working?

Users have the ability to input formulas into the Value fields of the Conditional Formatting modal. Use
Rational and Logical Operators to express what actions should take place when the desired criteria is
met. Follow the steps below to guide you through this feature. IF help is needed, use the Valid
Operators as a reference.

Relational Operators Logical Operators

= (Equals) Or, || (Double Pipe)
<> (Does Not Equal) And, &&
>= (Greater Than or Equal To)
<= (Less Than or Equal To)
> (Greater Than)
< (Less Than)

l To make a valid formula, you need at least one of the relational operators from the table above,
and at least one value.

l i.e. = Red

l i.e. >=0

l If you’re using any logical operators (i.e. &&) then you’ll need at least 2 relational operators and
at least 2 values per logical operator.

l i.e. >1 || <0

l Comparisons to Dates need to be specified in the YYYY-MM-DD format.

l i.e. < 2025-03-25, if you want all dates less than March 25th 2025 to be formatted.

Notes:
l To delete a saved online report, click the name of the report on the Charts & Reports
page and click Delete at the bottom of the page. Only the report owner, users assigned as
owners with All Reporting Rights, and Process Designers with All Reporting Rights can
delete the report.

l To include a project's thumbnail image in the report, add the Project Thumbnail column
available in the Project Details column set.

l A reference table must also be added to Accolade as an online report in order to be
available to use in reporting. The reference table information is included by selecting the
Reference Tables option when selecting columns to be included in the report.

l The process model determines whether the report is available at the project level. When
viewed through a project, only data that pertains to that project displays in the report,
unlessOverride project filtering is set in the report configuration. Non-project related



information displays identically in both locations. Click on the Reports page of the
project to print the list of charts and reports that display.

l Using filters that reference data with square brackets may not return correct results. It is
not recommended to use square brackets in naming projects or other Accolade data, as
these characters are not supported in filtering and calculation functionality.

l Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Data Format field when creating charts and reports.

l Users can now use the phrase "NULL_OR_EMPTY" in the Conditional Formatting feature
to format NULL/[EMPTY] values (Determined by the Replace Empty Values parameter 1
([EMPTY]) 0 (NULL)).

Adding Calculated Columns to Online Reports
Reporting details can be contained in multiple sources within Accolade. To combined related data
values to be used for reporting or the creation of charts or presentations, users can create reports that
include calculated columns that calculate and/or display combined data, allowing users to manipulate
and analyze Accolade data values.

For example, a user may have several different project metrics that represent categories of project costs
such as Administrative, Operating, Marketing, etc. In order to calculate and display the sum of these
project costs within an Accolade report or chart, the user can include a calculated column in their report
setup.

Example

Writing a calculated column formula in Accolade is slightly different than writing an equation in math
class, or using formulas in Excel. The most notable difference is the use of the equal sign (=).

For example, if you want to add the numbers 3 and 2:

l In math class, the equation would read 3+2=, with a calculated value of 5.
l In Excel, formulas start with the equal sign, so it would look like =3+2. When entered, the value in
the selected cell would return as 5. If you wanted to add two cell values, it would look something
like =A1+B1 or =SUM(A1:B1). Assuming the values in A1 and B1 were 3 and 2 respectively, it
would return the value 5.



l In Accolade online reporting, the equal sign is assumed, so it does not need to be included in the
formula field. If you wanted to add the values of Column A and Column B, it would look like
[Column A] + [Column B] or Sum([Column A], [Column B]). Assuming the first row values of
Column A and Column B were 3 and 2 respectively, it would return the value 5.

To add a calculated column to an online report:

Note: See below for a list of calculations that are currently supported for reporting.

1. Create a new report or open an existing report for editing.

2. On the Selected Columns tab, ensure the columns to be used in the calculation are included in
the report.

Report calculations are executed from left to right. In order for selected columns to
be used in a calculated column, they must a) be selected as a column for the
report, and b) be included before they are referenced by a calculated column (this
means they must appear to the left of the calculated column when displayed, or
above the calculated column when selecting columns in the report setup).

3. Make a selection in the Show check box to show or hide columns within the displayed report.

If you want to use the columns as a reference for calculated column formulas but do not wish to
display them in the report, clear the Show check box. Hidden columns can still be used as a
reference for calculated columns, but will not appear in the report when displayed.

4. Click Add Calculated Column.

The column is added with two fields - one for the display name for the column, and one for the
formula to be calculated.



5. In the top field, enter the column name to be displayed when the report is generated.

6. In the field, enter the formula to be calculated within the report.

When entering your formula, the columns are referenced by enclosing the column display name
inside of square brackets. In the example above, Column A is entered as [Column A].

7. Select the appropriate datatype for the calculated column.

l Date - Select this option when you want the column data to display as a Date datatype, for
example when using the DateAdd function to project a future project date.

l Number - Select this option when you want the column data to display as a Number datatype,
for example when using the Sum function to combine the values of two or more columns of
expense values.

l String - Select this option when you want the column data to display as a String datatype, for
example when using the Concatenate function to display user name and functions combined
in one column.

7. (Optional) Drag and drop the calculated column to a new location within the list.

Note that while the calculated column cannot be displayed in the report until after its reference
columns are displayed, you can have calculated columns that are displayed between data
columns as necessary. Using the example above, after the Sum column we could add Column
C and Column D to the report and then add another calculated column, and so forth.

8. ClickOK to exit the dialog and return to the report settings.

9. Finish setting up the report, as necessary.

10. (Optional) Click in the upper right corner to display a preview of the report contents prior to

saving, or click to download the report to a spreadsheet file.

11. Click Save to create a new report, or to save changes to an existing report.

Available Formulas for Calculated Columns in Reporting

The following section details the operators and functions that are available for use when creating your
calculated column formulas.

Important! Note that the examples use "Column A", "Column B", and "Column C" to
generically refer to the display names of different columns that are included in the report
data.

Operators

Operators are process or mathematical parts of expressions, such as addition and multiplication, and
relationships such as greater than or less than. Use the operators below within your calculated column
expressions.



Operator Example

Additive and Subtractive Operators

+ (plus, plus sign) [Column A]+[Column B]

- (minus, dash) [Column A]-[Column B]

Multiplicative Operators

* (multiplied by, asterisk) [Column A]*5

/ (divided by, slash) [Column A]/[Column B]

% (mod, percent sign) [Column A]%10

Primary Operators

value (integers, text strings,
dates, functions)

('this is a text string')

While single quotes work for dates,
we recommend wrapping dates in
pound or hash signs instead to
ensure consistency of data types.
For example, (#2021-10-19#).

( ) (parentheses) 1000-(6*[Column A])

Relational Operators

= (equals) [Column A]=250

<> (does not equal) [Column A]<>[Column B]

> (greater than, angle bracket) [Column A]>250

>= (greater than or equal to) [Column A]>=250

< (less than, angle bracket) [Column A]<500

<= (less than or equal to) [Column A]<=100

Logical Operators

or, || (double pipe) [Column A]<[Column B]||[Column A]<500

and, && [Column A]<[Column B]&&[Column A]<1000

Functions

The functions included in the calculated column formula determine in part what is returned in the
column. Use the functions described below within your calculated expressions to return data within a
calculated column.



For more information on the description or formatting for the calculations below, see Calculated Metric
Expressions Reference.

Function Example Formula

Abs Abs([Column A])

Acos Acos([Column A])

Asin Asin([Column A])

Atan Atan([Column A])

Avg Avg([Column A], [Column B], [Column C])

Ceiling Ceiling([Column A])

Concatenate Concatenate('text1',[Column A], 'text2', 'textN')

Contains Contains([Column A], 'My Blue Heaven', 2, 7)

Cos Cos([Column A])

DateAdd DateAdd('D', 5, [Column A])

DateDiff DateDiff('D',[Column A], [Column B])

DatePart DatePart('M', [Column A])

Exp Exp([Column A])

Find Find([Column A], 'My Blue Heaven', 2, 20)

First First([Column A], [Column B], [Column C])

Floor Floor([Column A])

IEEERemainder IEEERemainder([Column A], [Column B])

If If([Column A]>500, 'Go ahead', 'Stop')

In In([Column A], 1, 2, 3)

Join Join([Column A], [Column B], [Column C]), '|')

Length Length([Column A])

Log Log([Column A], 10)

Log10 Log10([Column A])

Lower Lower([Column A])

LTrim LTrim([Column A])

Max Max([Column A], [Column B], [Column C])
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Function Example Formula

Min Min([Column A], [Column B], [Column C])

Now Now()

Pow Pow([Column A], 2)

Replace Replace([Column A], 'Blue', 'red')

Round Round([Column A], 2)

RTrim RTrim([Column A])

Search Search('blue', [Column A], 5, 30).

Sign Sign([Column A])

Sin Sin([Column A])

Sqrt Sqrt([Column A])

SubString SubString([Column A], 4, 10)

Sum Sum([Column A], [Column B], [Column C])

Tan Tan([Column A])

Trim Trim([Column A])

Truncate Truncate([Column A])

Upper Upper([Column A])

Notes:
l To delete a calculated column from a report, click the name of the report on the Charts &
Reports page and click to display the report columns. Click the Selected Columns
tab, and click in the corresponding calculated column row to delete it. ClickOK to
close the dialog and click Save to save the changes to the report.

Adding Dynamic Filters to Online Reports
Capture and filter report data using relative metric and metadata field codes to create dynamic reports
that display data according to the project it is viewed within. Filtering reports based on relative metrics
and metadata field codes allows you to narrow the returned data set while still generating a higher-level
view. Dynamic filters allow you to view a subset of data from within different projects.

Important! Ensure theOverride project filtering check box is selected on the report
settings. This enables the report to include data across a subset of projects.



To add dynamic filters to an online report:

1. Create a new report, or open an existing report for editing.

2. Click in the upper right corner to view the report details, and click the Selected Filters tab.

3. To add filters, double-click or drag and drop the column names from the left side of the dialog to
any area in the Selected Filters tab.
l To search for a column to add as a filter, enter search criteria in the Find field after selecting
the subject.

l To include an entire column set, drag and drop the column set to any area in the Selected
Filters tab.

If multiple filters are added to the report, data must meet ALL filter criteria to be
included in the report.

4. For each added filter, select the operator and filter criteria that report data must match to be
included.

The filter operators are dependent on the column selected to filter by, and generally include
options such as =, is empty, is one of, does not contain, and more.

The filter type must be selected from one of the following, and the following field identifies the
criteria to be met:

l Metadata - Enter the field code display name and select from the returned list. Ensure you
enter a valid query field code. While some operators may work in global level reports, this filter
type is designed to only work in reports pulled into project layouts via the Report pod (project
level reports).

l Metric - Enter the metric display name and select from the returned list. While some operators
may work in global level reports, this filter type is designed to only work in reports pulled into
project layouts via the Report pod (project level reports).

l Text - Enter or select a static string or numeric value such as a date.
l Current User - Filters the report to data only applicable to the user logged in and viewing the
report. Current User is only available for numeric or ID data type columns.

Type ahead to search for metrics and field codes when defining the filter criteria.
Only metrics and field codes that match the data type of the filter display for
selection. For example, if you select a date filter, you can only select date metrics
or field codes to define the relative filter.

For example, to create a report that returns a list of deactivated users, filter on the User Active
column to return only users where the active flag is set to No. To set up this filter, the operator
selected is =, the type selected is Text, and the criteria is No.
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5. (Optional) Select the Runtime Filter check box to determine what filters are available for users
to apply when refreshing the data in the report.

6. ClickOK to exit the dialog and return to the report settings.

7. Finish setting up the report, as necessary.

8. (Optional) Click in the upper right corner to display a preview of the report contents prior to

saving, or click to download the report to a spreadsheet file.

9. Click Save to create a new report, or to save changes to an existing report.

Notes:
l To delete a filter from a report, click the name of the report on the Charts & Reports page
and click to display the report columns. Click the Selected Filters tab, and click in
the corresponding filter row to delete it. ClickOK to close the dialog and click Save to
save the changes to the report.

l Filter icon will not appear if there are no filters available for users to apply.

l Long string and multi-select list metrics are currently not supported for use as metric
filters.

Adding Multiple Matrices to Online Reports
Reporting details can be contained in multiple sources within Accolade. To consolidate data into a
single source to be used for reporting or the creation of charts or presentations, users can create reports
to combine the data. Information from more than one project matrix can be pulled into a report by
including a common value that is included in the sources, for example, using a Department or Region
metric or a common Row ID.

In addition to selecting the matrix and metric columns to be included in the report, users must create join
statements that define how the matrix information is related.



To add multiple matrices to an Accolade online report:

1. Create a new report or open an existing report for editing.

2. On the Selected Columns tab, select the matrices and metrics to be included in the report.

3. On the Advanced Matrix Settings tab, click Add to add the matrix join statements.

4. In each side of the dialog, select one of the matrices from the drop-down list, and select an option
to use as the common value to join the matrices.

The two selected matrices must be different, but the matrix/metric combination can be any
combination of metrics or row IDs, as long as the selected metrics share a common value and
are of the same data type.

Selecting a metric will define it as the common value between the two matrices. Note that it can
be the same metric if it is used in both matrices, or it can be different metrics that will have the
same value in both matrices. In addition, a metric used as a common value does not need to be
added as a reporting column in order to be used to create the join statement.

Selecting Row ID will compare matrices by rows, for example Row 1 in Matrix A will be compared
with Row 1 in Matrix B, and so on. This can be used when there are no additional common values
in the two matrices, and the matrices have a direct line-by-line comparison.

Caution! Selecting Row ID as a common value can cause inconsistencies in
reporting. Since assigned Row IDs are not visible within a matrix, report results
can be incorrect if rows have been deleted from a matrix or if there is a mismatch.



5. Repeat steps 3-4 to add additional matrix join statements as necessary.

All included matrices must have at least one related join statement, but a matrix can be
referenced in more than one statement. For example, if you choose to include metrics from
Matrix A, Matrix B, and Matrix C, you would need to create two statements to join the information.
You could create a statement that relates A to B, and one that relates B to C, or you could have a
statement that relates A to B, and one that relates A to C.

6. ClickOK to exit the dialog and return to the report settings.

7. Finish setting up the report, as necessary.

8. (Optional) Click in the upper right corner to display a preview of the report contents prior to

saving, or click to download the report to a spreadsheet file.

9. Click Save to create a new report, or to save changes to an existing report.

Note: [EMPTY] or blank cells in your report may indicate a mismatch in the common value
linking the matrices. If the project value referenced in the join statement is not defined
in one of the matrices, for example if there is not a matching value in both matrices, or
a matrix contains empty rows, the report will return partial or full rows that contain
[EMPTY] values.

Example

For example, a user has two different matrices that contain information related to vendor contracts for
their projects, and needs to create a report containing relevant information from both matrices. They
have a matrix named Contract Information, which contains the start date and duration of the specific
contracts, and a second matrix named Contract Cost, which contains the costs related to the specific
contracts.



To pull this information into one report, the user has added the related columns to the Columns tab, and
created a join statement in the Advanced Matrix Settings tab that links the two matrices using the
Contract IDmetric that is a member of both matrices.

Once the user enters the remaining report details and clicksOK, the following report is generated:

Note the following:

The Contract ID field is the common identifier included in both matrices, and used to connect the
relevant information.

The left three columns contain information that is from the Contract Informationmatrix in the related
projects.

The right three columns contain information that is from the Contract Costmatrix in the related
projects.

The highlighted sections below show two different scenarios that may indicate missing or incomplete
data.



l Rows 2 & 3 of the report display [EMPTY] in some of the data cells, which indicates Contract IDs
values that are not found in both matrices. In row 2, the information for contract A101 is only
included in the Contract Information matrix, so the related Contract Cost matrix fields are
[EMPTY]. In row 3, the information for contract A110 is only included in the Contract Cost matrix,
so the related Contract Information matrix fields are [EMPTY].

l Rows 10 & 11 display [EMPTY] cells in all of the data cells, which indicates that one or more of
the included matrices either does not have any rows added, or contains empty rows.

Note: Although the [EMPTY] returned values are an indicator of potential issues, the
mismatched values reported are dependent on the datatype. String and list metrics
will display as [EMPTY]. As shown in the example below, a number metric will display
0, and a date metric will represent the default 1/1/1900 date.

Notes:
l To delete a matrix join statement from a report, click the name of the report on the Charts
& Reports page and click to display the report columns. Click the Advanced Matrix
Settings tab, and click in the corresponding definition row to delete it. ClickOK to
close the dialog and click Save to save the changes to the report.

Exercises - Creating Online Reports
Try out what you have learned!

l Create a report using the online report that includes all open projects
that started after a date of your choosing.

l Limit the users that can edit the report configuration.

l Set the report to download onWednesday at 6:00 am.

l Create a bar chart that represents aspects of the report.



Downloading and Exporting Online Report Data
Users with access to a report can download the content of a saved online report directly from Accolade.
Report creators can also set a report to export to a network location on a scheduled basis. Schedule a
report for repeated exports if you save archive information on your network, or to provide access to a
report to someone who is not an Accolade user.

To download report configuration and settings for the purpose of exporting reports
between Accolade instances, see Importing and Exporting Accolade Online
Reports.

To download a saved online report:

1. From theWorkspacemenu, selectMy Workspace > Charts & Reports.

2. Click the name of the report you want to view.

identifies reports created using Accolade Office Extensions. To refine the list of reports
displayed, select a category from the Category field or use the Search field to search on report
names and descriptions. If the Category field is unavailable, all reports are grouped within a
single category.

3. Click in the top right corner of the report display page.

Accolade downloads the report contents to spreadsheet file and saves it to a temporary internet
files directory, using the report's system name as the file name. Save the file to a more
accessible location.

4. If the document is a template, Administrators and Process Designers with the Template Access
role can save the file and add it to the Template Library as a process document.

If the document is a deliverable, activity, or gate document, the assigned document owners can
save a version of the file to project.

To schedule a report to export to a network location:

1. From the Systemmenu, select Content Sources > Charts & Reports Manager.

2. Do one of the following:

l To create a new report - Click Add New, selectOnline Report from the drop-down list and
create a new report.
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l To edit the export settings of an existing report - Click the name of the report on the
Charts & Reports Manager page and click in the upper right corner of the title in the
displayed report.

3. In the Export Days field and the Export Time field, select the days of the week on which
Accolade should export and enter the time the export should take place.

You must select at least one day to schedule the export. The export takes place based on the
Accolade server's time, not your local time settings. If the Accolade server is located in a different
time zone, ensure you are scheduling the time accurately for the export.

4. Complete the following to identify the export location and report name:

Field Description

Export File Path Enter the directory location where the exported file is saved.

The Accolade timed task service must have access to the
network drive. Work with your system administrators to
understand what network shares are available for use.

Filename Enter the file name for the report. To append a timestamp to the
file name, select the Include timestamp check box.
Timestamps can be helpful to identify exactly when a report was
exported and saved to the network directory.

5. In the File Type field, select whether to download the file as a spreadsheet file, or as a file with a
.csv extension which can be opened in other spreadsheet programs.

If you select to download to CSV and have text set in the Report Privacy Warning Text system
parameter, the text is not included in the CSV file.

6. Click Save to save the report and the export settings.

Notes:
l The Timed Task Service must be enabled and running on the Accolade server for a
scheduled export to save successfully. Contact your Accolade system administrator to
ensure the service is running.

l If a scheduled export fails to save, the report creator receives a notification email about
the failure.

l The colors defined in the Excel Header Background Color, Excel Header Font Color,
and Excel Header Is Bold system parameters determine the formatting of the header
rows within the spreadsheet file.



Adding Accolade Online Reporting Content to Templates
Add the content of a report created within Accolade to an existing document or template using a specific
named range. When downloading the report, template, or a document version with the report content,
the up-to-date Accolade data is included in the file.

A spreadsheet template containing content created within Accolade can also be
used as the template for a deliverable or activity. Administrators and Process
Designers with the Template Access role can save the file and add it to the
Template Library as a Process Document type template instead of as a Report
type.

To add content from an online report to an existing spreadsheet file:

1. Note the system name of the report in Accolade.

2. Select the cell within the spreadsheet where the report content should begin.

When the file is downloaded from Accolade, the report contents start at the cell with the named
range, and expands to the right and below for the required number of columns and rows to
accommodate the data.

Important! Any information in cells to the right of the one with named range could be
deleted based on the report's content. Any information below the cell with the named range
is pushed to below the report's content.

3. In the Name field for the cell, enter SGM_RG_<RGReportName> and press Enter.

For example, to include a report with the system nameModelsInUse, enter SGM_RG_
ModelsInUse as the cell name.

Notes:
l Using this function to associate a spreadsheet workbook with report content to a project
does not display project level data.



Creating Charts from Report Data Overview
Online reports created within Accolade can be used to create new or copy existing charts that represent
all or a portion of the data that is returned in the report. Charting options vary, and a wide variety of
charts are included so you can create the best visual representation of the data in your system as
possible.

Note: Line Chart By Columns has been removed as a chart option in Charts & Reports and Charts &
Reports Manager. Users are encouraged to utilize Line Chart Trends as an alternative option.

Using Accolade online report data, users with All Reporting Rights can create charts on the Charts &
Reports page. Administrators and Process Designers can set charts as available for sharing with other
users, and can add a chart to a pod within a layout to display on a project page or as a global link.

Creating Bar Charts Based on Report Data
Bar charts use bars to represent and compare categories of data in a format that can be displayed
horizontally or vertically. One axis will generally have numerical values, and the other will describe the
types of categories being compared. In bar charts, the user can cycle through different views, that is,
different categories of data to get a more comprehensive view of a portfolio's performance using the
cycle icon .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart bars successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a bar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click the Bar
Chart icon.

l To edit the details of an existing report - Click the name of the chart on the Charts &
Reports page and click to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.



3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.More...

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners Click and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.



Field Description

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box



is selected, the chart will only be available to the assigned owners in theirMy
Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. In theGrouping field, select the column from the report that represents the data and
measurement values to plot on the chart.

l (Optional) To use the column names as labels for each axis, select the Display Axis Label
option for one or both axes.

l (Optional) In the Number Format drop-down, select an option to indicate how values for the
selected grouping display.

7. In the Bar field, select the column from the report that represents the data and measurement
values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

l (Optional) To use the column names as labels for each axis, select the Display Axis Label
option for one or both axes.

l (Optional) To display grid lines for the vertical axis, select the Show Grid Lines option.
l (Optional) To display values on the bars in the chart, select Display totals.
l (Optional) In the Number Format drop-down, select an option to indicate how values for the
bars display.

8. In the Cycles field, select one or many cycles. Each cycle displays a different grouping of data
that the bars represent. The Grouping selection is automatically selected and cannot be
unselected.

9. Enter the following information to alter the chart display:

Field Description

Display Type Select whether the bars display horizontally or vertically. The
chart rotates according to the display type. Number formats
specified in the report will also rotate since they apply to the data
and not the axis.

If the contents of your report produces enough bars
that the labels along the horizontal axis overlap, select
the Rotate Horizontal Axis Text option to display the
labels at an angle instead of horizontally to prevent
overlapping.

Color Theme Select the color palette to assign to the bars.



Field Description

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click in the upper right corner to view the new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Revenue, Region, and Yearmetrics to be included in the report.

To create a bar chart to display this information, the user has selected the Year for theGrouping value
and the Revenue as the Bar value. The bars represent the yearly sales values of various products.

To create a bar chart to display this information and cycle through the metrics for different chart views,
the user has selected the Year for theGrouping, the Revenue for the Bar, and the Product Lines,
Revenue, and Region as the Cycles values. The Product Lines in the report represent the business
units of Desktop, Tablets, Peripherals, Servers, and Mobile. The bars represent the yearly sales values
of the various products. Select the cycle icon to view the different charts.



Notes:

l To delete a saved chart, display the chart from the Charts & Reports page, click to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

l Before creating the chart, the user selects the sort order of the data in the associated
report.

l Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.



Creating Grouped Bar Charts Based on Report Data
Grouped bar charts use bars to represent and compare different categories of two or more sets of data
in a format that display horizontally or vertically. Because the categories are grouped and arranged side
by side, the grouped bar arrangement allows users to visually represent the differences inside a group.
The grouped bar chart can be used to showcase differences in the same category across groups.
Generally, in the chart, one axis has a value such as a product line, the other axis has numerical values
such as revenue, and the bar segments show categories to be compared. In grouped bar charts, the
user can cycle through different views, that is, different categories of data to get a more comprehensive
view of a portfolio's performance using the cycle icon .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart bars successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a grouped bar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Grouped Bar Chart icon.

l To edit the details of an existing report - Click the name of the chart on the Charts &
Reports page and click to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.



Field Description

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.More...

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners Click and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...



Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in theirMy
Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. In the Horizontal Axis field, select the column from the report that represents the data and
measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

l (Optional) To use the column name as a label for the axis, select the Display axis label
option.



l (Optional) In the Number Format drop-down, select an option to indicate how values for the
selected column display.

7. (Optional) In the Vertical Axis field, select the column from the report that represents the data
and measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

l (Optional) To use the column name as a label for the axis, select the Display axis label
option.

l (Optional) In the Number Format drop-down, select an option to indicate how values for the
selected column display.

l The Bars field displays a drop-down list to select one column.

8. In the Bars field, the user can select one or more columns from the report that represent each
bar within a group.

l If the user selected a Vertical Axis, then the user must select one column only from the
Column drop-down list. The chart renders by rows.

l If the user did not select a Vertical Axis, then the user can select multiple columns from the
box. The chart renders by columns.

9. Enter the following information to alter the chart display:

Field Description

Bar Axis Units Enter text to display as the vertical axis label.
Cycle Segments Horizontal Axis and Bars determines how the cycles are

mapped on the chart.

Horizontal Axis uses the selected cycle as the basis for the
horizontal axis. Barsmaps the selected cycle to the vertical
bars.

Cycles Select one or many cycles.

Each cycle displays a different column of data that the grouped
bars represent. The Horizontal Axis selection is automatically
selected and cannot be unselected.

Display Type Select whether the bars display horizontally or vertically. The
chart rotates according to the display type. Number formats
specified in the report will also rotate since they apply to the data
and not the axis.

If the contents of your report produces enough bars
that the horizontal axis labels overlap, select the
Rotate Horizontal Axis Text option to display the



Field Description

labels at an angle instead of horizontally to prevent
overlapping.

Number Format Select a number formatting option to indicate how values within
the chart are displayed.

Legend Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click in the upper right corner to view the new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Grouped Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenuemetrics to be included in the report.

To create a grouped bar chart to display this information, the user has selected the Region for the
Horizontal Axis, the Revenue for the Vertical Axis, the Product Lines as the Bars value, and
Product Lines, Revenue, and Year as the Cycles values. The Product Lines in the report represent
the business units of Desktop, Mobile, Peripherals, Servers, and Tablets. The bars represent the sales
values of various products. Select the cycle icon to view the different charts. Toggle a key label in
the legend to hide and show data in the rendered chart.



Notes:

l To delete a saved chart, display the chart from the Charts & Reports page, click to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

l Before creating the chart, the user selects the sort order of the data in the associated
report.

l Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.

Creating Stacked Bar Charts Based on Report Data
Stacked bar charts use a single bar to represent multiple categories of data in a format that display
horizontally or vertically. Because the categories are arranged in a stack, the stacked bar arrangement
allows users to visually represent and compare total sizes of bars and relative differences in categories.
The stacked bar chart can be used to showcase when one category overtakes another. Generally, in



the chart, one axis has a value such as a product line, the other axis has numerical values such as
revenue, and the bar segments show categories to be compared. In stacked bar charts, the user can
cycle through different views, that is, different categories of data to get a more comprehensive view of a
portfolio's performance using the cycle icon .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart bars successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a stacked bar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Stacked Bar Chart icon.

l To edit the details of an existing report - Click the name of the chart on the Charts &
Reports page and click to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.More...

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.



Field Description

l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners Click and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.



Field Description

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in theirMy
Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. In the Horizontal Axis field, select the column from the report that represents the data and
measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

l (Optional) To use the column name as a label for the axis, select the Display axis label
option.

l (Optional) In the Number Format drop-down, select an option to indicate how values for the
selected column display.



7. (Optional) In the Vertical Axis field, select the column from the report that represents the data
and measurement values to plot on the chart.

l The chart draws negative and positive data points as greater than or less than a zero-value
line. If charting only positive values, the chart draws bars as greater than zero.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

l (Optional) To use the column name as a label for the axis, select the Display axis label
option.

l (Optional) In the Number Format drop-down, select an option to indicate how values for the
selected column display.

l The Bar Segments field displays a drop-down list to select one column.

8. In the Bar Segments field, the user can select one or more columns from the report that
correlate to the stacked sections of the bars.

l If the user selected a Vertical Axis, then the user must select one column only from the
Column drop-down list. The chart renders by rows.

l If the user did not select a Vertical Axis, then the user can select multiple columns from the
box. The chart renders by columns.

l Check one or both check boxes to display values.

l Select Stacked to 100% to display the bar segments as percentages of the whole
rather than integer values.

l Select Display totals to include the total value for the entire bar after the last segment.

9. Enter the following information to alter the chart display:

Field Description

Bar Axis Units Enter text to display as the vertical axis label.
Cycle Segments Horizontal Axis and Bars determines how the cycles are

mapped on the chart.

Horizontal Axis uses the selected cycle as the basis for the
horizontal axis. Barsmaps the selected cycle to the bar
segments.

Cycles Select one or many cycles.

Each cycle displays a different segment of data that the stacked
bars represent. The Horizontal Axis selection is automatically
selected and cannot be unselected.

Display Type Select whether the bars display horizontally or vertically. The
chart rotates according to the display type. Number formats
specified in the report will also rotate since they apply to the data
and not the axis.

If the contents of your report produce enough bars that



Field Description

the horizontal axis labels overlap, select the Rotate
Horizontal Text option to display the labels at an
angle instead of horizontally to prevent overlapping.

Number Format Select a number formatting option to indicate how values within
the chart are displayed.

Legend Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

10. (Optional) Add target lines to display on the chart.

11. (Optional) If you edited an existing chart, click in the upper right corner to view the new chart.

12. Click Save to save your changes and create the chart.

Example - Creating Stacked Bar Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenuemetrics to be included in the report.

To create a stacked bar chart to display this information and cycle through the metrics for different chart
views, the user has selected the Region for the Horizontal Axis, the Revenue for the Vertical Axis,
the Product Lines as the Bar Segments value, and Product Lines, Revenue, and Year as the
Cycles values. The Product Lines in the report represent the business units of Desktop, Tablets,
Peripherals, Servers, and Mobile. The bar segments represent the various products by category across
region and revenue over several years. Select the cycle icon to view the different charts. Toggle a
key label in the legend to hide and show data in the rendered chart.



Notes:

l To delete a saved chart, display the chart from the Charts & Reports page, click to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

l Before creating the chart, the user selects the sort order of the data in the associated
report.

l Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.



Creating Bubble Charts Based on Report Data
Bubble charts (also known as bubble plots) are multi-dimensional graphs that are a cross between a
scatter plot and a proportional area chart, and can be useful for comparing the relationships between
projects in multiple dimensions. Data points are plotted against a horizontal and vertical axis, and then
have additional data values represented by the size and color of the bubble. In bubble charts, the user
can cycle through different views, that is, different categories of data to get a more comprehensive view
of a portfolio's performance using the cycle icon .

Important! Select numeric data types for Bubble Represents values to render a
meaningful chart. The system will not prevent you from selecting different data types and will
plot selected data as best as possible without error.

To create a bubble chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Bubble Chart icon.

l To edit the details of an existing report - Click the name of the chart on the Charts &
Reports page and click to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.More...



Field Description

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners Click and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...



Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in theirMy
Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. In the Horizontal Axis and Vertical Axis fields, select the columns from the report that
represent the data and measurement values to plot on the chart.

l (Optional) To use the column names as labels for each axis, select the Display Axis Label
option for one or both axes.

l (Optional) To display grid lines for the horizontal and vertical axis, select the Show Grid
Lines option.

l (Optional) Select the Rotate Horizontal Axis Text option to display the labels at an angle
instead of horizontally to prevent overlapping.



l (Optional) In the Number Format drop-down, select an option to indicate how values on the
axis are displayed.

l (Optional) In Scale Control, change the scaling and size of the displayed chart by selecting
one of the following options:

l Select Automatic to set the chart range minimum and maximum values displayed in the
chart based on the data ranges in the report.

l Select Custom to manually set the chart Range Minimum and Range Maximum values
displayed in the chart.

7. Select the following information to define what the bubbles within the chart represent:

Field Description

Bubble Size Select a number metric from the report that determines the size
of each bubble in the chart.

Number Format Select how values display within the tooltip for the bubbles in the
chart.

Bubble Represents Select the information that displays within the tooltip for the
bubbles in the chart.

Selecting [None] displays only the bubble's value in the tooltip.
Bubble Color Select the column that determines what each color represents in

the chart.
Bubble Opacity Select how solid to display the bubbles in the chart.

Using a smaller value displays the bubbles less opaque, and can
make each easier to see if bubbles overlap in the chart.

Cycles Select one or many cycles. Each cycle displays a different
grouping of data that the bubbles represent.

The Bubble Color selection is automatically selected and cannot
be unselected.

Color Theme Select the color palette to assign to the bubbles in the chart.
Legend Select where in the chart to display the key that identifies what

the bubble colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

8. (Optional) If you edited an existing chart, click in the upper right corner to view the new chart.

9. Click Save to save your changes and create the chart.

Example - Creating Bubble Charts in Accolade

For example, a user wants to review and compare the financial reward and customer benefit by region
for a portfolio of products over the last several years. The user has created a Product Line Revenues



Report for their report source, and selected the Product Lines, Region, Revenue, Year, Financial
Reward, and Customer Benefitmetrics to be included in the report.

To create a bubble chart to display this information and cycle through the metrics for different chart
views, the user has selected:

l Horizontal Axis - Customer Benefit
l Vertical Axis - Financial Reward
l Bubble Size - Revenue
l Bubble Represents - Region
l Bubble Color - Product Lines
l Cycles - Year and Region

The Product Lines in the report represent the business units of Desktop, Tablets, Peripherals, Servers,
and Mobile. The bubbles represent the various products by category across region and revenue over
several years. The bubble location on the chart shows the high customer benefit and financial reward in
the upper right corner and low values in the lower left corner to help you identify possible investments.
Select the cycle icon to view the different charts. Toggle a key label in the legend to hide and show
data in the rendered chart.

Notes:

l To delete a saved chart, display the chart from the Charts & Reports page, click to



display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

l Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.

Creating Line Chart Trends Charts Based on Report Data
Line Chart Trends charts are created by connecting a series of data points together with a solid line, and
layering multiple lines within one chart to display or analyze trends or patterns in several related sets of
data. In line chart trends, the user can cycle through different views, that is, different categories of data
to get a more comprehensive view of a portfolio's performance using the cycle icon .

Important! Select appropriate data types to render a meaningful chart. Numeric data types
will chart lines successfully. The system will not prevent you from selecting different data
types and will plot selected data as best as possible without error.

To create a line chart trends chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click the Line
Chart Trends icon.

l To edit the details of an existing report - Click the name of the chart on the Charts &
Reports page and click to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.



Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.More...

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners Click and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data



Field Description

rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in theirMy
Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.



6. In the Horizontal Axis section, make the following selections:
l (Optional) Enter a description in the Label field to display a label for the horizontal axis.
l (Optional) Select the Rotate Horizontal Axis Text option to display the labels at an angle
instead of horizontally to prevent overlapping.

l (Optional) Select the Show Grid Lines option to display grid lines for one or both axes.
l (Optional) Select the Start at Zero option to display the data range along the horizontal axis
in relation to 0.More...

When the Start at Zero check box is not selected, the data range for the horizontal
axis will be determined by the lowest and highest available data values.

For example, you have data points that are all between the values of 6 and 10 that are being
graphed along the horizontal axis. Selecting the Start at Zero option will display a graph that
displays the value range of 0 to 10 along the horizontal axis to show the relation of the data to
the origin. If Start at Zero is not selected, the graph will display the value range of 6 to 10
along the horizontal axis.

l (Optional) In the Number Format drop-down, select an option to indicate how values on the
axis are displayed.

l In the Column drop-down list, select the column from the report that represents the data and
measurement values to plot on the horizontal axis of the chart.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

7. In the Vertical Axis section, make the following selections:
l (Optional) Enter a description in the Label field to display a label for the vertical axis.
l (Optional) Select the Show Grid Lines option to display grid lines for one or both axes.
l (Optional) In the Number Format drop-down, select an option to indicate how values on the
axis are displayed.

l Select the Lines columns from the report that represent the data and measurement values to
plot on the vertical axis of the chart.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.

8. (Optional) In theGroup By field, select columns from the report to apply line groupings to the
data presented in the graph.

Adding additionalGroup By selections introduces more lines to your display which
may impact chart use.

9. (Optional) Select the Display Point Marker check box to display the grid points.

10. In the Cycles field, select one or many cycles. Each cycle displays a different grouping of data
that the lines represent. The Horizontal Axis selection is automatically selected and cannot be



unselected.

11. Enter the following information to alter the chart display:

Field Description

Style Select whether to display lines only, or lines with fill below.
Legend Select where in the chart to display the key that identifies what

the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme Select the color palette to assign to the bars.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20 plotted values.

12. (Optional) If you edited an existing chart, click in the upper right corner to view the new chart.

13. Click Save to save your changes and create the chart.

Example - Creating Line Chart Trends Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenuemetrics to be included in the report.

To create a line trends chart to display this information and cycle through the metrics for different chart
views, the user has selected the Year for the Horizontal Axis Label, the Product Lines as the
Column value, the Revenue for the Vertical Axis Label, the Revenue for the Lines, the Region for
theGroup By value, and Revenue, Region, and Year as the Cycles values. The Product Lines in the
report represent the business units of Desktop, Tablets, Peripherals, Servers, and Mobile. The line
segments represent the various products by category across region and revenue over several years.
Select the cycle icon to view the different charts. Toggle a key label in the legend to hide and show
data in the rendered chart.



Notes:

l To delete a saved chart, display the chart from the Charts & Reports page, click to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

l Use the Currency Symbol system parameter to specify the currency symbol that
displays in the Number Format field when creating charts and reports.

Creating Pie Charts Based on Report Data
Pie charts present categories of data as slices of a pie, where each category is represented as a
percentage of the whole value of the chart. In pie charts, the user can cycle through different views, that
is, different categories of data to get a more comprehensive view of a portfolio's performance using the
cycle icon .



Important! Select numeric data types for the Slice Represents values to render a
meaningful chart. The system will not prevent you from selecting different data types and will
plot selected data as best as possible without error.

To create a pie chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click the Pie
Chart icon.

l To edit the details of an existing report - Click the name of the chart on the Charts &
Reports page and click to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.More...

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.



Field Description

Empty categories are deleted automatically.
Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners Click and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.

4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.



Field Description

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in theirMy
Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. Select the following information to define the slices within the pie chart and how they display:

Field Description

Slice Represents Select the data column that contains the row items that the slices
in the pie represent.

Slice Size Select the numeric data column that determines the size of the
slices in the pie.

Cycles Select one or many cycles.

Each cycle is a data column that contains the row items that the
slices in the pie represent. The Slice Represents selection is
automatically selected and cannot be unselected.

Slice Name Select to include the name of the pie slice as part of the slice's
label.

Slice Value or Slice
Percentage

Select whether to label the pie slices by value or percentage of
the pie included in the slice.

You can select one or both, or select neither to display the slices
with no values.



7. Select the following attributes to define the pie chart's style:

Field Description

Doughnut Displays the pie with an empty space in the middle.

Exploded Displays the pie with space between each piece.

Number Format Select a number formatting option to indicate how the values in
the chart are displayed. 

Color Theme Select the color palette to assign to the pie sections of the chart.

If plotting 10 or more data points, consider a color theme to
accommodate each value measurement. Themes 2-5 allow for
up to 20-25 plotted values.

Legend Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

8. (Optional) If you edited an existing chart, click in the upper right corner to view the new chart.

9. Click Save to save your changes and create the chart.

Example - Creating Pie Charts in Accolade

For example, a user wants to review and compare the revenue by region for a portfolio of products over
the last several years. The user has created a Product Line Revenues Report for their report source,
and selected the Product Lines, Region, Year, and Revenuemetrics to be included in the report.



For example, a user wants to review and compare last year's sales revenue numbers for several
projects. The user has created a Sales Performance report for their chart report source, and selected
the Project Name and Sales Year 1metrics to be included in the report.

To create a pie bar chart to display this information and cycle through the metrics for different chart
views, the user has selected the Product Lines for the Slice Represents, the Revenue for the Slice
Size, and the Region, Year, and Revenue as the Cycles values. The Product Lines in the report
represent the business units of Desktop, Tablets, Peripherals, Servers, and Mobile. The slices
represent the various products by category across region and revenue over several years. Select the
cycle icon to view the different charts. Toggle a key label in the legend to hide and show data in the
rendered chart.

To create a pie chart to display this information, the user has selected Project Name as the Slice
Represents value, and Sales Year 1 as the Slice Size value, to create slices that represent each
project's sales revenue as a portion of the company's overall sales total.

Notes:
l Percentages in pie charts truncate after the first decimal place therefore the total may not
always equal 100%. For example, 27.786% will display as 27.7%.

l Negative values are not included in the pie chart.

l To delete a saved chart, display the chart from the Charts & Reports page, click to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.



l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

l Before creating the chart, the user selects the sort order of the data in the associated
report.

Creating Radar Charts Based on Report Data
Radar charts are multi-dimensional graphs that display data values based on a shared center axis, and
can be useful for comparing properties of a single component, or for performance analysis and
determining when one variable is performing differently than the rest.

Important! Select spokes with numeric data types to render a meaningful chart. The system
will not prevent you from selecting different data types and will plot selected data as best as
possible without error.

To create a radar chart based on report data:

1. From theWorkspacemenu, select Charts & Reports.

To narrow the list, search by the chart name or category.

Note: Process Designers can also create or edit charts, reports, and related configuration by
navigating to the Systemmenu and selecting Content Sources > Charts & Reports
Manager.

2. Do one of the following:

l To add a new chart - Click Add New, select Chart from the drop-down list, and click the
Radar Chart icon.

l To edit the details of an existing report - Click the name of the chart on the Charts &
Reports page and click to edit the report details. Only users assigned as chart owners and
Process Designers with All Reporting Rights can edit chart details.

3. Enter the following information to identify the chart:

Required fields display with red text and an asterisk * if the field is empty.

Field Description

Name Enter a name, up to 64 characters long, which identifies the
chart.

To display this name as the chart's title, select the
Display as title option.



Field Description

System Name Enter a unique, shorter name that identifies the chart in queries,
reporting views, field codes, and other places in Accolade.

The name must be unique among charts and can contain only
letters (English alphabet), numbers, and the underscore.

Category Enter or select the group to which this chart belongs.More...

Use categories to organize like charts together. For example,
you may choose to group all the charts used in global layouts
into the same category, in order to separate them from charts
that are used in process model layouts or other reporting.
l Leave this field blank to add to the Default category.
l To define a new category, select New Category and enter
the category name.

l To delete a category, remove every item from the category.
Empty categories are deleted automatically.

Description Enter a description of the purpose or nature of the chart.

This description helps other users identify the chart on the
Charts & Reports page.

Owners Click and select the additional users who can edit the chart

details.

To filter the list of users, enter one or more search criteria to filter
by name, login name, email address, function, or extended field.
More...
l Clicking Select current user will assign the role to the
current user (if they have the appropriate rights).

l Selecting a Function in the drop-down will display available
users that are assigned to the function. The current selection
defaults to the function to which you are assigning a user,
however depending on the project configuration, you can
assign any user.

l Clicking Clear Filters removes the current user assignment
and displays [None] to indicate that no user is assigned.

An assigned owner with All Reporting Rights can view,
update, delete, or add additional owners to the chart.
An assigned owner who has Refresh Workbook Data
rights will only be able to view the chart. To make the
chart available for all users or for configuration setup,
you must have a Process Designer with All Reporting
Rights as an assigned owner.



4. (All optional, available in configuration only) Enter the following information to make the chart
publicly available.More...

Field Description

Available to Charts &
Reports

Select this check box to make the chart publicly available for
users to access and view the chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart in the Shared Charts & Reports section on
the Charts & Reports page.

Available to
Configuration

Select this check box to make the chart available for use in
configuration.

Specific Roles Select the system user roles that have access to view the
chart.

Users with one or more matching user roles and either
Refresh Workbook Data or All Reporting Rights will be able
to view the chart on the Charts & Reports page.

Configuration
Access Groups

When either Available to check box is checked, access
groups must be defined for the chart.

The access groups displayed are based on the current user's
access group permissions and the access groups the chart
belongs to. Additionally, Process Designers with matching
permissions will be able to edit and view the chart.

Process Model
Usage

(Available for existing charts) Click on the Process Model
Usage button to see a list of process models that the online
chart is associated with.

The list displayed includes all process models the chart is
included in, as well as links to the process model's
component tree pages you have Edit access to.

Note: Clicking either Available to check box will place the chart in the Shared
Charts & Reports section of the Charts & Reports page. If neither check box
is selected, the chart will only be available to the assigned owners in theirMy
Charts & Reports section.

5. In the Report Source field, select the report that contains the data to include in the chart. Only
online reports created in Accolade are available for selection.

6. In the Polygons field, select the column from the report that represents the data and
measurement values to plot on the chart.

l If a column within the report contains a selected Aggregate value, the aggregation displays
automatically when the report column is selected to display in a chart.



7. In the Spokes field, select the columns from the report that represent the data and measurement
values to plot as groupings or areas of the values.

8. Enter the following information to alter the chart display:

Field Description

Scale Control Select the scaling and size of the displayed chart.
l Select Automatic to set the chart range minimum and
maximum values displayed in the chart based on the data
ranges in the report.

l Select Custom to manually set the chart Range Minimum
and Range Maximum values displayed in the chart.

Number Format Select a number formatting option to indicate how the values in
the chart are displayed.

Style Select how the polygon shapes charting the data display.

If you select Lines and Fill or Fill Only, select how solid to
display the shapes in the chart in the Polygon Opacity field.
Using a smaller value displays the polygons less opaque, and
can make each easier to see if polygons overlap in the chart.

Legend Select where in the chart to display the key that identifies what
the colors in the chart represent.

After the chart renders, toggle a key label in the legend to hide
and show data without changing the underlying chart and report
configuration.

Color Theme Select the color palette to assign to the regions.

9. (Optional) If you edited an existing chart, click in the upper right corner to view the new chart.

10. Click Save to save your changes and create the chart.

Example - Creating Radar Charts in Accolade

For example, a user wants to review their portfolio of projects, and identify which ones continue to best
fit their company's overall strategy based on a set of current gate scores. The user has created a
Business Opportunity Report for their chart report source, and selected the Project Name,Market
Strategy Alignment, Customer Need,Market/Customer Attractiveness, Technical Strategy
Alignment, and Customer Benefitmetrics to be included in the report.

To create a radar chart to display this information, the user has selected Project Name as the
Polygons value, and theMarket Strategy Alignment, Customer Need,Market/Customer
Attractiveness, Technical Strategy Alignment, and Customer Benefitmetrics as the Spokes
values to create shapes that compare the gate scores for various projects. Toggle a key label in the
legend to hide and show data in the rendered chart.



Notes:

l To delete a saved chart, display the chart from the Charts & Reports page, click to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.

Adding Target Lines to Bar Charts
In order to characterize Accolade data more completely, it can be helpful to include a threshold line or
target value indicators to your chart. Bar charts include an option to display and hide target data for a
project or portfolio. Users can add target lines to grouped, stacked, and vertical bar charts to visually
represent a benchmark line and add context for the viewer. Adding interpretation to the data
visualization helps the viewer understand the information being presented in the chart.

To add target lines to a bar, grouped bar, or stacked bar chart:

1. From the Project > Charts & Reports page, click the name of the chart and click to edit the
chart details.

2. In the Target Line Report Source field, select the online report to be referenced.



The Target Line Report Source does not have to be the same report as used for
the chart's Report Source. If the Report Source and the Target Line Report
Source are different reports, the values in the Target Line Report Key column
should match the values in theGrouping column.

3. In the Target Line Report Key and Target Line Report Value fields, select the report columns
from the selected source above that will be referenced to create target lines.

The Target Line Report Value controls what values the targets lines display in the chart.
l If the Target Line Report Source column selected contains rows with unique values, the
Target Line Report Value will display the relative metric value as the target line.

l If the Target Line Report Source column selected contains rows with duplicate values, the
target line will display as the aggregated totals of the Target Line Report Valuemetric values
from each row of data.

l When Cycle Segments is set to Horizontal Axis, the target lines will only be applied to the
original value, as defined for the horizontal axis.

Examples 1 & 2 discuss how to create a chart with target lines using one or multiple chart sources, and
the Target Line Report Source column contains unique values per project. Example 3 discusses how to
create a chart with target lines using aggregated metric totals.

Example 1 - Bar Charts Using One Report Source

For example, a user has several different projects that are all reporting yearly sales numbers, and wants
to review how each project performed against their individual sales target. For the report, the user has
created a Project Sales Report that includes the Project Name, and selected the Total Sales and
Sales Forecastmetrics to be included in the report.

Using the Project Sales Report as the source for both the chart and the target lines, make the following
selections for a bar chart:

l For the chart setup, select Project Name as theGrouping value and Total Sales as the Bar
value, to create bars that represent the total sales for each project.

l For the targets setup, select Project Name as the Target Line Report Key value and Sales
Forecast as the Target Line Report Value, to create target lines that represent the sales
targets for each project.

The user could include additional sales data metrics in the chart and report in order to create grouped
bar and stacked bar charts to represent additional comparison views.

Example 2 - Bar Charts Using Different Report Sources

Using the same scenario from Example 1, the user is again reviewing how each project performed
against their individual sales target. In this example, the user will still create a report to gather the yearly
sales numbers from the projects, however the sales targets are defined in a reference table stored in
Accolade, so they will need to create a second report to use this table information to create target lines.



For the chart report, the user has created a Project Sales Report that includes the Project Name, and
selected the Total Salesmetric to be included in the report. For the target line report, the user has
created a Sales Reference Table report that uses the reference table data for its information source.

Using the Project Sales Report as the source for the chart, and the Sales Reference Table as the
source for the target lines, make the following selections for a bar chart:

l For the chart setup, select Project Sales Report as the Report Source, Project Name as the
Grouping value and Total Sales as the Bar value, to create bars that represent the total sales
for each project.

l For the targets setup, select Sales Reference Table as the Target Line Report Source,
Project as the Target Line Report Key value and Sales Goal as the Target Line Report
Value, to create target lines that represent the sales targets for each project.

As with the single source grouped bar and stacked bar examples, the user can include additional
metrics in their chart and reports in order to visually represent the comparisons.

Example 3 - Bar Charts Using Aggregated Metric Totals

In this scenario, the user has several regions that are being reviewed against their regional yearly sales
targets. There are multiple projects within each region, so the user needs to aggregate both the sales
numbers and the total sales forecast for each region. For the report, the user has created a Regional
Sales Report that includes data for all of the projects in the region, and selected the Sales Region,
Total Sales, and Projected Salesmetrics to be included in the report.

Using the Regional Sales Report as the source for both the chart and the target lines, make the
following selections for a bar chart:

l For the chart setup, select Regional Sales Report as the Report Source, Sales Region as the
Grouping value and Total Sales as the Bar value, to create bars that represent the total sales
numbers for each region. Since there are multiple projects in each region, the bar will display the
aggregated Total Sales value.

l For the targets setup, select Regional Sales Report as the Target Line Report Source, Sales
Region as the Target Line Report Key value and Projected Sales as the Target Line Report
Value, to create target lines that represent the total sales targets for each region, Again since
there are multiple projects in each region, the target line will display the aggregated Projected
Sales value.

As with the previous examples, the user can include additional metrics in their chart and reports in order
to visually represent the comparisons.

Important!When adding targets to bar charts, keep the following guidelines in mind:

l Select appropriate data types and values to render a meaningful chart and targets.
The system will not prevent you from selecting different data types and will plot
selected data as best as possible without error.



l Target lines can be turned on and off by clicking on the Targets legend within the
chart.

l Target lines are only valid for use in bar charts that are displayed vertically.

l In stacked bar charts, target lines will not display if Stacked to 100% is selected.

Notes:

l To delete a saved chart, display the chart from the Charts & Reports page, click to
display the chart settings, and click Delete at the bottom of the page. Only the chart
owner, users assigned as owners with All Reporting Rights, and Process Designers with
All Reporting Rights can delete the chart.

l If the Replace Empty Value system parameter is set to 0, charts may render
inconsistently due to empty or missing data returned by the report.

l Reporting Rights are not required to view the chart in a page layout; however a user must
be an owner or have at least one matching user role for the chart to display in the layout.



Accolade Excel Reports Overview
Accolade Excel reports can be added to the Charts & Reports page within Accolade and/or to a
process model for availability within a project. These reports are built and viewable in Excel, provide
flexibility in formatting, and can be created using the Accolade Office Extensions add-in application. The
application provides an interface to create a data report based on Accolade data.

Creating Accolade Excel Reports using Accolade Office Extensions
With the Accolade Office Extensions add-in, anyone in your organization with All Reporting Rights can
create a report in Excel using the add-in.

Reports created via the Accolade Office Extensions add-in provides the following advantages:

l No SQL knowledge is required. You can select Accolade data directly from the report interface
without writing SQL queries.

l Reports can be refreshed when downloaded from Accolade to contain up-to-date information
and formatted for distribution or review, query-based tables cannot.

Use the Report Privacy Warning Text system parameter to add a notification
within the report to indicate the content is private or confidential, and should not be
forwarded to others.

The information below assumes you are using the Accolade Office Extensions add-in to create reports
and assumes you are familiar with basic Excel functionality. For more information about manipulating
the data in a report, see the online Help available from within the add-in.

To create an Accolade Excel report:

1. Open Excel and navigate to the Accolade menu in the Excel ribbon.

This allows Excel to pull data from Accolade into the report and allows reports to be created or
refreshed to display current Accolade information.

If necessary, connect to the appropriate server by clicking Server and entering the
server URL.

2. Click Data Reports and do one of the following:
l To add a new report - Click Add New.

l To create a report based on an existing report - Click to copy the report.

l To edit an existing report - Click the name of the report to open it for editing.

3. Select a subject from the drop-down list, such as Projects or Users, to display the column sets
available within that subject.



4. Double-click or drag and drop the column names from the left side of the dialog to any area in the
Columns tab to include the column in the report.
l To search for a column, enter search criteria in the Find field after selecting the subject.

l Use the and options to expand or collapse the subject data sets in order to select
specific column options.

l To include an entire column set, drag and drop the column set to the Columns tab.
l To change the column order of selected columns, drag and drop a column into a new location
within the list.

l To remove a column, click in the corresponding row.

5. (Optional) Refine the content of the report as necessary.More...
l Rename columns - Click in one or more selected columns and enter a new column name
that is more appropriate for the report you are creating.

l Set column sorting - Click next to one or more selected columns to indicate whether the
column is sorted in ascending or descending order. If you select more than one column to
sort by, indicate the order in which the columns sort; 1 being the primary sort, 2 the
secondary sort, and so on.

l Determine column properties - For number and date columns, click or in the
Properties area to group data together by aggregation or select date formats. Select the
aggregate method or date format and click away to apply the changes. All selected
aggregate methods are added to the report columns list with the aggregate method
appended to the column name.

For example, to summarize the total costs for all projects within a brand, select Sum as the
aggregate value in a column that represents the total costs for a project.

l Add Count Column - If you select to summarize values within the report, click Add
Count Column to add a column that shows how many rows of source data are combined in
the summary row.

You can order and rename the added column as you can other columns; however,
you can add only one Count column to the report.

l Add Calculated Column - Click Add Calculated Column to add a column to the report
that displays a calculation based on other column data.

6. (Optional) On the Filters tab, double-click or drag and drop the column name from the left side of
the dialog to any area in the Filters tab to use it as filter criteria that data must match to be
included in the report.

7. (Optional) On the Report Details tab, add the following information:

Field Description

Report Name Enter a name which identifies the report.



Field Description

Report Location Select one of the following options for the location to place the
report:
l Existing worksheet - Select this check box to add the report
to an existing worksheet that does not already contain a
report, and select the appropriate existing worksheet name
from the drop-down list.

l New worksheet - Select this check box to create and add the
report to a new worksheet, and enter the name for the new
worksheet.

Override Project
Filtering

Select this check box to include the entire report set from within
a project.

The report will not filter to project-specific data when viewed
from within a project, and will display all projects in a portfolio
regardless of security.

Transpose Select this check box to transpose the column and row data
when the report is rendered.

8. On the Advanced Matrix Settings tab, if more than one matrix was selected in the report
columns, click Add to add the matrix join definitions.

9. Click Done to apply your changes and generate the report.

10. Save the report to an accessible location.

Notes:
l Click Refresh Columns in the lower left of the dialog to refresh the columns. Any
columns modified in the Accolade application while the user is creating or editing the
report will be updated. Deleted columns will be removed from list of available columns
and will display red in the Columns tab and Filters tab. Delete the selections in red to
correct the report.

l To delete a saved report created in Excel, click Data Reports in the Accolade menu on
the Excel ribbon and click next to the corresponding report. Deleting a report created
using the Accolade Office Extensions add-in deletes report data being pulled from
Accolade into the workbook. Deleting a report directly from the worksheet does not delete
the data associated with the report.
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Adding Calculated Columns to Accolade Excel Reports
Reporting details can be contained in multiple sources within Accolade. To combined related data
values to be used for reporting or the creation of charts or presentations, users can create reports that
include calculated columns that calculate and/or display combined data, allowing users to manipulate
and analyze Accolade data values.

For example, a user may have several different project metrics that represent categories of project costs
such as Administrative, Operating, Marketing, etc. In order to calculate and display the sum of these
project costs within an Accolade report or chart, the user can include a calculated column in their report
setup.

Example

Writing a calculated column formula in Accolade is slightly different than writing an equation in math
class, or using formulas in Excel. The most notable difference is the use of the equal sign (=). For
example, if you want to add the numbers 3 and 2:

l In math class, the equation would read 3+2=, with a calculated value of 5.
l In Excel, formulas start with the equal sign, so it would look like =3+2. When entered, the value in
the selected cell would return as 5. If you wanted to add two cell values, it would look something
like =A1+B1 or =SUM(A1:B1). Assuming the values in A1 and B1 were 3 and 2 respectively, it
would return the value 5.

l In an Accolade Excel report created using the Accolade Office Extensions add-in, the equal sign
is assumed, so it does not need to be included in the formula field. If you wanted to add the
values of Column A and Column B, it would look like [Column A] + [Column B] or Sum
([Column A], [Column B]). Assuming the first row values of Column A and Column B were 3
and 2 respectively, it would return the value 5.



To add a calculated column to an Accolade Excel report:

Note: See below for a list of calculations that are currently supported for reporting.

1. Create a new report or open an existing report for editing.

2. On the Columns tab, ensure the columns to be used in the calculation are included in the report.

Report calculations are executed from left to right. In order for selected columns to
be used in a calculated column, they must a) be selected as a column for the
report, and b) be included before they are referenced by a calculated column (this
means they must appear to the left of the calculated column when displayed, or
above the calculated column when selecting columns in the report setup).

3. Click Add Calculated Column.

The column is added with two fields - one for the display name for the column, and one for the
formula to be calculated.

4. In the left field, enter the column name to be displayed when the report is generated.

5. In the field, enter the formula to be calculated within the report.

When entering your formula, the columns are referenced by enclosing the column display name
inside of square brackets. In the example above, Column A is entered as [Column A].

6. Click to select the appropriate datatype for the calculated column.

l Date - Select this option when you want the column data to display as a Date datatype, for
example when using the DateAdd function to project a future project date.

l Number - Select this option when you want the column data to display as a Number datatype,
for example when using the Sum function to combine the values of two or more columns of
expense values.

l String - Select this option when you want the column data to display as a String datatype, for
example when using the Concatenate function to display user name and functions combined
in one column.



7. (Optional) Drag and drop the calculated column to a new location within the list.

Note that while the calculated column cannot be displayed in the report until after its reference
columns are displayed, you can have calculated columns that are displayed between data
columns as necessary. Using the example above, after the Sum column we could add Column
C and Column D to the report and then add another calculated column, and so forth.

8. Finish setting up the report, as necessary.

9. Click Done to apply your changes and generate the report.

10. Save your changes to the report.

Available Formulas for Calculated Columns in Reporting

The following section details the operators and functions that are available for use when creating your
calculated column formulas.

Important! Note that the examples use "Column A", "Column B", and "Column C" to
generically refer to the display names of different columns that are included in the report
data.

Operators

Operators are process or mathematical parts of expressions, such as addition and multiplication, and
relationships such as greater than or less than. Use the operators below within your calculated column
expressions.

Operator Example

Additive and Subtractive Operators

+ (plus, plus sign) [Column A]+[Column B]

- (minus, dash) [Column A]-[Column B]

Multiplicative Operators

* (multiplied by, asterisk) [Column A]*5

/ (divided by, slash) [Column A]/[Column B]

% (mod, percent sign) [Column A]%10

Primary Operators

value (integers, text strings,
dates, functions)

('this is a text string')

While single quotes work for dates,
we recommend wrapping dates in
pound or hash signs instead to
ensure consistency of data types.



Operator Example

For example, (#2021-10-19#).

( ) (parentheses) 1000-(6*[Column A])

Relational Operators

= (equals) [Column A]=250

<> (does not equal) [Column A]<>[Column B]

> (greater than, angle bracket) [Column A]>250

>= (greater than or equal to) [Column A]>=250

< (less than, angle bracket) [Column A]<500

<= (less than or equal to) [Column A]<=100

Logical Operators

or, || (double pipe) [Column A]<[Column B]||[Column A]<500

and, && [Column A]<[Column B]&&[Column A]<1000

Functions

The functions included in the calculated column formula determine in part what is returned in the
column. Use the functions described below within your calculated expressions to return data within a
calculated column.

For more information on the description or formatting for the calculations below, see Calculated Metric
Expressions Reference.

Function Example Formula

Abs Abs([Column A])

Acos Acos([Column A])

Asin Asin([Column A])

Atan Atan([Column A])

Avg Avg([Column A], [Column B], [Column C])

Ceiling Ceiling([Column A])

Concatenate Concatenate('text1',[Column A], 'text2', 'textN')

Contains Contains([Column A], 'My Blue Heaven', 2, 7)

Cos Cos([Column A])
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Function Example Formula

DateAdd DateAdd('D', 5, [Column A])

DateDiff DateDiff('D',[Column A], [Column B])

DatePart DatePart('M', [Column A])

Exp Exp([Column A])

Find Find([Column A], 'My Blue Heaven', 2, 20)

First First([Column A], [Column B], [Column C])

Floor Floor([Column A])

IEEERemainder IEEERemainder([Column A], [Column B])

If If([Column A]>500, 'Go ahead', 'Stop')

In In([Column A], 1, 2, 3)

Join Join([Column A], [Column B], [Column C]), '|')

Length Length([Column A])

Log Log([Column A], 10)

Log10 Log10([Column A])

Lower Lower([Column A])

LTrim LTrim([Column A])

Max Max([Column A], [Column B], [Column C])

Min Min([Column A], [Column B], [Column C])

Now Now()

Pow Pow([Column A], 2)

Replace Replace([Column A], 'Blue', 'red')

Round Round([Column A], 2)

RTrim RTrim([Column A])

Search Search('blue', [Column A], 5, 30).

Sign Sign([Column A])

Sin Sin([Column A])

Sqrt Sqrt([Column A])

SubString SubString([Column A], 4, 10)



Function Example Formula

Sum Sum([Column A], [Column B], [Column C])

Tan Tan([Column A])

Trim Trim([Column A])

Truncate Truncate([Column A])

Upper Upper([Column A])

Notes:
l To delete a calculated column from an Accolade Excel report, click Data Reports in the
Accolade menu on the Excel ribbon and click the name of the report to open it for editing.
Expand the Columns tab, and click in the corresponding calculated column row to
delete it. Click Done to apply your changes and generate the report and save your
changes to the report.

Adding Dynamic Filters to Accolade Excel Reports
Capture and filter report data using relative metric and metadata field codes to create dynamic reports
that display data according to defined filters within the report. Filtering reports based on relative metrics
and metadata field codes allows you to narrow the returned data set while still generating a higher level
view. Dynamic filters allow you to view a subset of data from within different projects.

Important! Ensure theOverride project filtering check box is selected on the report
settings. This enables the report to include data across a subset of projects.

To add dynamic filters to an Accolade Excel report:

1. Create a new report, or open an existing report for editing.

2. Click and expand the Filters tab.

3. To add filters, double-click or drag and drop the column names from the left side of the dialog to
any area in the Filters tab.
l To search for a column to add as a filter, enter search criteria in the Find field after selecting
the subject.

l To include an entire column set, drag and drop the column set to any area in the Filters tab.

If multiple filters are added to the report, data must meet ALL filter criteria to be
included in the report.

4. For each added filter, select the operator and filter criteria that report data must match to be
included.



The filter operators are dependent on the column selected to filter by, and generally include
options such as =, is empty, is one of, does not contain, and more.

The filter type must be selected from one of the following, and the following field identifies the
criteria to be met:

l Metadata - Enter the field code display name and select from the returned list. Ensure you
enter a valid query field code.

l Metric - Enter the metric display name and select from the returned list.

l Text - Enter or select a static string or numeric value such as a date.
l Current User - Filters the report to data only applicable to the user logged in and viewing the
report. Current User is only available for numeric or ID data type columns.

Type ahead to search for metrics and field codes when defining the filter criteria.
Only metrics and field codes that match the data type of the filter display for
selection. For example, if you select a date filter, you can only select date metrics
or field codes to define the relative filter.

For example, to create a report that returns a list of deactivated users, filter on the User Active
column to return only users where the active flag is set to No.

5. (Optional) Select the Prompt on Refresh check box to prompt the user to review and/or update
the filters when refreshing the data in the report.

6. Finish setting up the report, as necessary.

7. Click Done to apply your changes and generate the report.

8. Save your changes to the report.

Notes:
l To delete a filter from an Accolade Excel report, click Data Reports in the Accolade menu
on the Excel ribbon and click the name of the report to open it for editing. Expand the
Filters section, and click in the corresponding filter row to delete it. Click Done to
apply your changes and generate the report, and save your changes to the report.

l Long string and multi-select list metrics are currently not supported for use as metric
filters.
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Adding Multiple Matrices to Accolade Excel Reports
Reporting details can be contained in multiple sources within Accolade. To consolidate data into a
single source to be used for reporting or the creation of charts or presentations, users can create reports
to combine the data. Information from more than one project matrix can be pulled into a report by
including a common value that is included in the sources, for example, using a Department or Region
metric or a common Row ID.

In addition to selecting the matrix and metric columns to be included in the report, users must create join
statements that define how the matrix information is related.

To add multiple matrices to an Accolade Excel report:

1. Create a new report or open an existing report for editing.

2. On the Advanced Matrix Settings tab, select the matrices and metrics to be included in the
report.

3. Click Add to add the matrix join statements.

4. In each side of the dialog, select one of the matrices from the drop-down list, and select an option
to use as the common value to join the matrices.

The two selected matrices must be different, but the matrix/metric combination can be any
combination of metrics or row IDs, as long as the selected metrics share a common value and
are of the same data type.

Selecting a metric will define it as the common value between the two matrices. Note that it can
be the same metric if it is used in both matrices, or it can be different metrics that will have the
same value in both matrices. In addition, a metric used as a common value does not need to be
added as a reporting column in order to be used to create the join statement.

Selecting Row ID will compare matrices by rows, for example Row 1 in Matrix A will be compared
with Row 1 in Matrix B, and so on. This can be used when there are no additional common values
in the two matrices, and the matrices have a direct line-by-line comparison.

Caution! Selecting Row ID as a common value can cause inconsistencies in
reporting. Since assigned Row IDs are not visible within a matrix, report results
can be incorrect if rows have been deleted from a matrix or if there is a mismatch.



5. Repeat steps 3-4 to add additional matrix join statements as necessary.

All included matrices must have at least one related join statement, but a matrix can be
referenced in more than one statement. For example, if you choose to include metrics from
Matrix A, Matrix B, and Matrix C, you would need to create two statements to join the information.
You could create a statement that relates A to B, and one that relates B to C, or you could have a
statement that relates A to B, and one that relates A to C.

6. Finish setting up the report, as necessary.

7. Click Done to apply your changes and generate the report.

Note: [EMPTY] or blank cells in your report may indicate a mismatch in the common value
linking the matrices. If the project value referenced in the join statement is not defined
in one of the matrices, for example if there is not a matching value in both matrices, or
a matrix contains empty rows, the report will return partial or full rows that contain
[EMPTY] values.

Example

For example, a user has two different matrices that contain information related to vendor contracts for
their projects, and needs to create a report containing relevant information from both matrices. They
have a matrix named Contract Information, which contains the start date and duration of the specific
contracts, and a second matrix named Contract Cost, which contains the costs related to the specific
contracts.

To pull this information into one report, the user has added the related columns to the Columns tab, and
created a join statement in the Advanced Matrix Settings tab that links the two matrices using the
Contract IDmetric that is a member of both matrices.



Once the user enters the remaining report details and clicks Done, the following report is generated.

Note the following:

The Contract ID field is the common identifier included in both matrices, and used to connect the
relevant information.

Columns B-D contain information that is from the Contract Informationmatrix in the related projects.

Columns E-G contain information that is from the Contract Costmatrix in the related projects.

The highlighted sections below show two different scenarios that may indicate missing or incomplete
data.

l Rows 5 & 6 of the report display [EMPTY] in some of the data cells, which indicates Contract IDs
values that are not found in both matrices. In row 5, the information for contract A101 is only
included in the Contract Information matrix, so the related Contract Cost matrix fields are



[EMPTY]. In row 6, the information for contract A110 is only included in the Contract Cost matrix,
so the related Contract Information matrix fields are [EMPTY].

l Rows 13 & 14 display [EMPTY] cells in all of the data cells, which indicates that one or more of
the included matrices either does not have any rows added, or contains empty rows.

Note: Although the [EMPTY] returned values are an indicator of potential issues, the
mismatched values reported are dependent on the data type. String and list metrics
will display as [EMPTY]. As shown in the example below, a number metric will display
0, and a date metric will represent the default 1/1/1900 date.

Notes:
l To delete a matrix join statement from an Accolade Excel report, click Data Reports in
the Accolade menu on the Excel ribbon and click the name of the report to open it for
editing. Click the Advanced Matrix Settings tab, and click in the corresponding
definition row to delete it. Click Done to apply your changes and generate the report and
save your changes to the report.

Refreshing Data in Accolade Excel Reports
When you open an Excel report on the Charts & Reports page, the file is automatically downloaded to
your computer and refreshed with the most current data from Accolade. You can refresh the data in
Excel files that have been saved to your computer if all of the following are true:

l You have the Accolade Office Extensions add-in installed on your computer.

l The report was created using Accolade Office Extensions.

l You have user rights to refresh data for Reporting (see your profile page).

l Your computer can access the Accolade server.

Reports created using SQL queries do not contain refresh options once the file is saved from Accolade.

The information below assumes you are using the Accolade Office Extensions add-in to create reports.



To refresh Accolade data when opening an MS Excel report:

1. View the chart or report from the Charts & Reports page.

The file is automatically downloaded to your computer and refreshed. If you save the file to your
computer, the next time you open it you are prompted to select whether to refresh the Accolade
data.

2. Select one of the following options:

l Click Yes to refresh and be prompted again the next time you open the file.
l Click No to not refresh, but be prompted next time you open the file.
l Select the Use my response each time check box and click Yes to always refresh without
being prompted.

l Select the Use my response each time check box and click No to never refresh, and not be
prompted about it again.

Your selection is saved for this file and applies only to your user.

Note: If you selected filters to prompt on refresh, a dialog displays allowing you to modify
filters before refreshing the data.

Notes:
l To refresh Accolade data in reports after opening an MS Excel report, navigate to the
Accolade menu in the Excel ribbon and click Refresh Reports.

l Reports created in Excel using the Accolade Office Extensions add-in can be embedded
in deliverables. The same refresh procedures described above apply to those reports as
well.

Updating Filters in Accolade Excel Reports
Depending on a report's setup, you may be prompted to modify filters that select the data included
within the report. Update the filters to see what effect those changes have on the tables and charts in
the report, and as a result can view an alternative scenario. For example, if a chart shows projects with a
certain range of estimated Net Present Value (NPV), you can see the effect of moving the range higher
or lower.

The information below assumes you are using the Accolade Office Extensions add-in to create reports.

To modify filters in an MS Excel report:

1. View the report and refresh the Accolade data, as necessary.

If you are prompted to refresh report filters. click Yes to modify the filters.

2. Change the condition, filter values, or both for the selected filter(s).



If the filter is used on multiple reports, click to view and modify the filters on individual reports.
If you modify the filter at the top level, it will apply globally across all reports contained in the
workbook.

3. Click Done to apply your changes and generate the report.

The reports in the file are refreshed using the changed filter values.

Notes:
l Changes that you make to the filters are saved if you save the file. These changes are
saved with the version that you save; they are not saved to the version saved within
Accolade.

l If you are not given the option to modify the filters, but you have Accolade Office
Extensions installed on your computer, you can save the file to your computer and modify
the source report to make the filters editable.

Exercises - Refresh Accolade Data in MS Excel Reports
Try out what you have learned!

l Open a chart and report.

l Refresh data in both charts and reports after opening the MS Excel
file.

l Change a filter and refresh again to see how the report changes.
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